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T U T O R I A L SeecompAccounting_*.xlsm 
 

INTRODUCTION – TIPS – COMMANDS 

 

To use SeecompAccounting_*.xlsm , minimum knowledge of Double Accounting (double-
entry accounting) and Excel is required.  

The program can be very powerful for Excel connoisseurs and can be instructive for those who 
want to deepen their knowledge in Accounting and Excel.  

MP4 videos are available in English to learn how to use the Program. Those who have 
diƯiculty understanding English can play the video without the audio and, with the necessary 
pauses, lean on reading the Tutorial that corresponds to the text in the videos. For those less 
familiar with Excel the video may be too fast and therefore, with the reading, it is possible to 
make pauses and repetitions as you like.   

The Demo Program only allows the introduction of 100 lines in the ACC_JOURNAL Sheet.  

When you make important changes such as deleting all the Sheets you are not interested 
in, press File Save and close the Program. Then reload it. This is because some Macros 
can be influenced and it happens, due to an imperfection of Excel, that when you start 
them, they are not recognized and the Program closes. 

For those who find the Program interesting and are willing to proceed with the purchase with 
the possibility of entering 8,000 lines in the sheet ACC_JOURNAL, they must follow the 
following procedure:  

Deposit via PayPal $24 or $39 depending on whether you want to use the Program 
 on 1 or 2 devices. When you pay the amount, you will have to indicate  
 

1. Your e-mail 
2. The Mac Addresses of the devices you want to use. You can get Mac Adress by 

viewing the UTILITY Sheet and pressing the corresponding MAC_ADRESS Form 
Control. Be careful not to give incorrect directions and check well before sending the 
amount.  
The compilation of the purchased program is done by copying and pasting the e-
mail and Mac Adress, and if you give an incorrect e-mail or an incorrect Mac 
Adress, you may not receive the Program, or the Program does not work because 
they are not correct in Mac Adress. 

3. Indicate whether you want the Program in 32-bit or 64-bit.  
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Those who own devices with high-speed processors and a lot of memory can increase the 
rows and in this case address directly to   

seecompacc@outlook.com 

 

8000 rows require memory easily available for devices without having “memory 
overflow". 

These data will be processed by our collaborators who will reply to your e-mail by attaching 
the File SeecompAccounting_8000_64/32_1/2.xlsm depending on the number of devices 
desired. Your Mac Addresses will be entered into the Macros and then the compilation will 
take place so as not to allow access for Copyright© reasons. 
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COMMANDS AVAILABLE TO THE USER 

 

1. A_ACC_JOURNAL 
This command is used to rename the Sheet when the ACC_JOURNAL Sheet is active. 
Be careful to use this command only if there are no Sheets with the same name as in 
this case it will give an error signal. 
 

2. A_BALANCE 
This command is used to rename the Sheet when the BALANCE Sheet is active. 
 Be careful to use this command only if there are no Sheets with the same name as in 
this case it will give an error signal. 
 

3. ACC_CONTROL 
With this Command you proceed to the Control of Accounts and other general checks. 
In the Program there are columns that must contain only Accounts, only 1 2 3 4, only 
date, only amount, only percentage. Form Control ACC_CONTROL helps you find if 
there are any incorrect or omitted introductions. We recommend watching the specific 
video. 
 

4. ACC_JOURNAL_NAME 
This command renames the active sheet to the name ACC_JOURNAL. Be careful to 
use this command only if there are no Sheets with the same name as in this case it 
will give an error signal. 
 

5. ACC_NUMBER_B(ALANCE) 
This command can be found in the BALANCE Sheet and is used to obtain the report of 
a specific Account. This only works if you place the cursor on the Account for which 
you want to extract the trend. If the cursor is not positioned, it does not work, and you 
will get an error message. Each Account must have a correct date in the 
ACC_JOURNAL Sheet. Otherwise you will receive a "mismatch" message.   
 

6. ACC_NUMBER_J(OURNAL) 
This command can be found in the ACC_JOURNAL Sheet and is used to obtain the 
report of a specific Account. This only works if you place the cursor on the Account for 
which you want to extract the trend. If the cursor is not positioned, it does not work, 
and you will get an error message. Each Account must have a correct date in 
ACC_JOURNA Sheet. Otherwise, you will get a "mismatch" message.   
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7. ACC_IN  

This command located in the ACC_JOURNAL Sheet is used to enter an entry in the 
Balance Sheet + Income statement. The registration must be complete with date 
(which will be used when you use the ACC_NUMBER_J/B command), debit account, 
credit account, amount and in the case of VAT percentage negative VAT in case of 
sale and positive in case of investment. The amount will be filled in pink after the 
introduction and will turn yellow after the calculation of the Balance Sheet + 
Income statement with the Form Control BALANCE in ACC_JOURNAL Sheet. The 
Cursor must be positioned over the amount, otherwise it will not work.  
 

8. ACC_OUT 
This command located in the ACC_JOURNAL Sheet is used to remove an entry in 
Balance Sheet + Income Statement previously entered with the Form Contro 
ACC_IN. The cursor must be positioned on the amount, otherwise it will not work. 
 

9. ACTIVE_SHEET 
This command returns the number of the Active Sheet on which you are placed. If 
the Form Control is not present, you can copy it from the UTILITY Sheet. Another 
solution: go to Developer → Macro → and search for ACTIVE_SHEET, mark and go to 
RUN. 
The Sheet number is used to rename this Sheet with CHANGE in the UTILITY Sheet . 
 

10. B_ACC_JOURNAL 
Equal function of Form Control A_ACC_JORNAL. It gives the possibility to have 
multiple names quickly for certain Sheets. You can also rename it by activating the 
Sheet, right-click and Rename. With Form Controls you rename faster.  
 

11. B_BALANCE 
How Form Control A_BALANCE. It is used to rename. The observations already made 
for the commands suitable for this purpose are valid.  
 

12. BALANCE 
This Form Control is located in the ACC_JOURNAL Sheet and pressing it launches the 
calculation of Balance Sheet + Income statement that we will find in the BALANCE 
Sheet  and also performs the calculation (at the end) that will indicate whether the 
calculation is correct or not. You will find this at the end after the Income Statement. 
The Key Sheets of the Program that cannot be missing are those coloured in red 
and are 
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BALANCE 
ACC_JOURNAL 
ACC_CONTROL 
ACC_NUMBER 
UTILITY 
 
The Balance sheet + Income statement in BALANCE Sheet processed is that is, with 
the first sums highlighted in yellow. The sum of the yellows in brown. The sum of the 
browns in blue and the total sums in purple. For the inexperienced it is easy to 
remove some of the dozens of automated sums. To avoid this, it would be 
necessary for the inexperienced to protect these cells against accidental 
deletion.  
 

13. BALANCE_NAME 
Rename the Active Sheet to BALANCE. The observations already made for the 
commands relating to renaming Sheets apply.  
 

14. C_ACC_JOURNAL 
It works like Form Control A_ACC_JOURNAL and Form Control B_ACC_JOURNAL. 
 

15. C_BALANCE 
It works like Form Control A_BALANCE and Form Control B_BALANCE. 
 

16. CHANGE 
We find it in the UTILITY Sheet and is used to rename the Sheets. Just enter the 
number of the sheet you want to rename where indicated, the new name and press 
CHANGE. Instead of the Sheet number, you can also enter the name of the Sheet. If 
the Sheet already exists, Excel gives an error sign.  
 

17. MAC_ADRESS 
We find it in the UTILITY Sheet and is used to obtain the MAC_ADRESS of your device 
in case you want to proceed with the purchase of the Program with 8000 lines available 
to the user. The purchase Methods are indicated in the introduction.  
 

18. MISMATCH 
This command helps us find improper inscriptions where they shouldn't be. When 
you press it, it analyses all the columns that should have precise inscriptions and 
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brings to the beginning extraneous inscriptions that will, then be searched for and 
corrected, in the Sheets where they were found.  
 
 
 

19. END_ROW_B(alance) 
By pressing END_ROW_B(alance) you go to the end of the Balance Sheet + Income 
Statement so that you can see the Controls and the Profit/Loss at the same time, 
which in case of accuracy must be the same.  
 

20. END_ROW_J(ournal) 
This command places the cursor in the ACC_JOURNAL Sheet to be able to continue 
with new subscriptions. 
 

21. TOP_ROW 
This command places us at the beginning of both the BALANCE Sheet and the 
ACC_JOURNAL Sheet. In VBA, the Excel right cursor does not only work on the specific 
rows where there are the inscriptions but includes all the 8000 rows where the program 
intervenes. Therefore, these commands help a lot to position yourself within the rows 
used.  
 

22. SCROLL_ROWS_F(orward)20 
Pressing this command advances the cursor 20 lines. It is repeated that the cursor on 
the right of Excel undergoes changes with the use of VBA. 
 

23. SCROLL_ROWS_B(ackword)20 
Pressing this command moves the cursor back 20 lines.  
 

24. UTILITY 
This command, if desired, activates the UTILITY Sheet. In any case, just press the 
UTILITY Sheets to get the same result.  
 

25. VAL_ADD_TAX_INV 
The Command stands for Value Added Tax Investment. We need it when we make a 
registration subject to VAT. The specific video shows how it works. Remember that the 
VAT percentage for investment has a positive sign while for Sales a negative sign.  
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26. VAL_ADD_TAX_SALE 
The Command stands for Value Added Tax Sale. We need it when we make a 
registration subject to VAT. The specific video shows how it works. Remember that the 
VAT percentage for investment has a positive sign while for Sales a negative sign. 
 

27.  CURRENCY COINS 
In the latest versions in the UTILITY Sheet the possibility of having diƯerent coins 
available has been introduced and in particular 
 
US Dollars 
Ponds sterling 
Euro 
Real 
Yen  
Rubles 
Swiss Francs 
Any Symbol where possible with VBA 
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  000. DOUBLE ENTRY ACCOUNTING = SIMPLE MATH 

Introducing the VBA SeecompAccounting_*.xlsx program for Excel 

Double-entry accounting is mainly based on four elements: 

1. Balance Sheet: this is where we see the assets and liabilities of the accounting system 

It is divided into: 

1. Assets (assets have a positive sign +) 
1.1 Current assets: assets that are immediately available, such as bank accounts, short-
term receivables, etc. 
1.2 Fixed assets: assets that are not immediately available, such as securities, real estate, 
long-term receivables, etc. 

2. Liabilities (liabilities have a negative sign -) 
2.1 Short-Term Debt Capital: debts to be paid in the short term, such as invoices, loans, etc. 
2.2 Long-Term Debt Capital: debts such as mortgages, long-term loans, etc. 
2.3 Equity: includes share capital, legal reserves, payments from shareholders or third 
parties, etc. 

We have reduced everything to the essentials. The Sections mentioned can be divided into 
groups and subgroups, as can be seen in the BALANCE Sheet of the 
SeecompAccounting_*.xlsm program and we can also see it in a very simplified form by way 
of example. 

2. Income Statement:  

      Here you can find: 

1. Costs (costs have a positive sign +): these are expenses that can reduce equity if they 
represent consumption (e.g. payment of telephone bills) or can offset an asset (e.g. purchase 
of land: the money leaves the bank – Current Assets – but is offset by an increase in Fixed 
Assets). 

2. Revenues (revenues have a negative sign -): normally increase Assets, such as income 
from sales or services that increase the Bank Account. 

3. Chart of Accounts: 

It is simply a list of account numbers, each with a description, that must be defined before 
any accounting entry is posted. 

A complete Balance Sheet and Income Statement must be prepared in advance; each 
account must have a description. 
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The Chart of Accounts is the basis of the Balance Sheet and the Income Statement. 

4. Journal: 

All the accounting entries for the year are recorded here in Sheet ACC_JOURNAL. Each entry 
contains the date, description, debit account number, corresponding credit account 
number and amount.  

This is the essential structure: more details will be introduced later. 

With the above, we have the theoretical basis to begin to understand Double-entry 
Accounting. Practical examples are available in the SeecompAccounting_*.xlsm files. Let's 
see an example of writing in the Sheet ACC_JOURNAL, ignoring for now the VAT (which will be 
explained in the part relating to the commands of the program). We use English terminology 
as in the video tutorials. You can request translation into another language via CoPilot or 
ChatGPT. 

 
Abbreviations of accounting items: 
 
Account            AC                
Active                             AS          
Curent assets  CAS                
Fixed assets              AGO  
Liabilities               LIA                          
Third party capital (Short &Long-Term)       TPC                          
Equity         EQU  
Costs                      COS                                        
Revenues                     REV                                       
Balance Sheet               BSH                                       
Profit & Loss Statement Statement       PLS                          
Opening                     OPE  
Debits                        DEB                                         
Credit                            CRE                                  
Balance                   BAL                                           
 
 
 
Assign:  
 
AcCAS→1:n Current Assets Accounts from 1 to n 
AcFA→1:m Fixed Asset Accounts from 1 to m 
 
AcTPC→1:k Debt Capital Accounts from 1 to k 
AcEQU→1:o Equity Accounts  from 1 to o 
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AcCOS→1:p Cost Accounts 1 to p 
AcREV→1:q Revenue Accounts a 1 a q 
 
 
JOURNAL Example 
 
We need to enter the following actions in the Journal 

1. Purchase of fuel by bank card by amount  Af 
2. Purchase of land with bank loan for amount Aq 
3. Provision of services and collection on bank account in amount Ah 
4. Sale of a Company Computer for cash for Ak amount 
5. Purchase of company car through leasing for Ag amount 
6. Loan repayment by bank transfer for Am amount 

 
  

DATE DESCRIPTION DEBITS(+) CREDITS(-) AMOUNT 
Date x Fuel/Bank AcCOSw AcCASg Af 
Data k Land / Mutual Bank AcFAt AcTPCq Aq 
Date v Bank / Services to third parties AcCASg AcREVg Ah 
Date u Bank / Computer Sales AcCASe AcTPCp Ak 
Date j Auto /Debito leaisng AcFAr AcTPCc Ag 
Date b Reimbursement / Bank AcTPCs AcCASg Am 
     
     

 
 
 
Registrations may increase during the year, however, we must note that the sum of the 
amounts associated with the DEBITS account are equal to the sum of the amounts 
associated with the CREDITS account, as the amount of the account corresponds to the 
amount of the against account.  
 
SUM COL H BALANCE Sheet = SUM COL I BALANCE Sheet  = SUM COL G ACC_JOURNAL Sheet 

These entries are transferred to the Balance Sheet and the Income Statement as follows: 

 Each account of the Balance Sheet and the Income Statement has a description 
(Chart of Accounts) 

 The amount in Debits (Col E) of the ACC_JOURNAL Sheet is reported in the Debits 
Column (H) of the same account in BALANCE Sheet 

 The amount in Credits (Col F equal to the debits) in ACC_JOURNAL Sheet  is reported 
in Credits column I in BALANCE of the corresponding account. 

 The associated accounts will no longer be side by side, but each in its own position 
corresponding to the account number in the BALANCE Sheet 

 In the end, the sum total of all the amounts Col G of ACC_JOURNAL sheet must 
match the total of the sum of the amounts in the Debits column and in the Credits 
column of the Balance Sheet + Income Statement. This is due to the fact that a 
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transaction has taken place of amounts associated from the accounts of the 
ACC_JOURNAL Sheet to the BALANCE Sheet which, as already expressed, are no 
longer side by side but each amount must be entered in the corresponding 
account of the Balance Sheet + Income Statement. 

In summary, we obtain with the help of the colors where we observe that we have a color in 
DEBITS and CREDITS and how they should be added or subtracted in the BALANCE, 
remembering that  

BALANCE = OPENING + DEBITS – CREDITS    Col J = Col G+ Col H- Col I        

The OPENING is not considered in the COSTS and REVENUES: if it is indicated, it is for 
information purposes only for the previous year but is not considered for the current 
year.  

BALANCE SHEET + INCOME STATEMENT 

ACCOUNTS DESCRIPTION OPENING DEBIT (+) CREDIT (-) BALANCE (=) 
 ASSETS     

AcCASg Bank Ox Ah Af+Aq+Am 
Ox+Ah - 

(Af+Aq+Am) 
AcCASe Case Oe Ak  Oe + Ak 

AcFAt Land Oz Aq  Oz + Aq 
AcFAp Office Equipment Oy  Ak Oy - Ak 
AcFAe Vehicles Op Ag  Op + Ag 

 LIABILITIES     

AcEQs Holder Loan Os Am  Os + Am 
AcTPCc Leasing car Ob  Ag Ob - Ag 

 COSTS     

AcCOSw Fuel  (Ol) Af  Af 

 
REVENUES 
 

    

AcREVg Revenues from Services (Of)  Ah Ah 

As we have seen, the data of the Journal are transferred to the Balance Sheet and the Income 
Statement. Video tutorials further illustrate this step and help you understand double-entry or 
double-entry accounting. 

Note that the SUM of all ACC_JOURNAL Sheet amounts (Col G) is equal to the sum of the 
amounts in the DEBITS COLUMS H and the CREDITS COLUMN I of the Balance Sheet + 
Income Statement. 
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We repeat how the colors and the comparison between the tables help us to understand how 
the amounts of the Journal end up in the DEBITS and CREDITS of the Balance Sheet + Income 
Statement and, in particular, in DEBITS with the sign [+] and in CREDITS with the sign [-]. This 
means that the sum of the BALANCE Sheet + Income statement at the end of the year (the 
openings in the Income Statement are only indicative) is equal to the sum of the OPENINGS In 
the Balance Sheet (=0) but the (ASSETS(+) + LIABILITIES(-)) of Saldo is no longer = 0 because 
the entries from the Journal have changed the addends and some have ended up in the 
COSTS and REVENUES. 

 To get back the sum of (ASSETS(+)+LIABILITIES(-)) = 0 we must therefore add or subtract, 
depending on whether we will have losses or gains, the difference between COSTS and 
REVENUES. 

Additional Notes: 

 The opening balances of Costs and Revenues do not appear in the Income Statement. 
 The result of the Income Statement derives from: 

∑ Costs (+) + ∑ Revenue (-) = Profit/Loss 
Profit → sign (-)   
Loss → sign (+) 
 

To simplify: 

 ASSETS       = Total Assets 
 LIABILITIES   = Total Liabilities 
 COSTS       = Total Costs 
 REVENUE     = Total Revenue 

 

When setting up a company, the first entries can look like this: 

Date Newspaper Description Debits (+) Credits (-) Amount 
Dates To Member's payment to bank account AcCASa AcEQa Aa 
Dates To Investor deposit to bank account AcCASb AcEQb Ab 

First Balance Sheet + Income Statement at the beginning of year 

ACCOUNTS DESCRIPTION OPENING     DEBITS (+) CREDITS (-) BALANCE (=) 
AcCAS Bank  Aa + Ab  Aa + Ab 

AcEQ Shareholder   Aa -Aa 

AcEQ Investor   Ab -Ab 
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First Balance Sheet at the beginning  
ASSETS [+] + LIABILITIES [-] = 0         (Aa+Ab-Aa-Ab)=0 
 

After enrolment at the end of the first year: 

ASSETS [+] + LIABILITIES [-] + COSTS [+] + REVENUES [-] = 0 
→ COSTS [+] + REVENUES [-] = PROFIT/LOSS [+/-] 
→ ASSETS [+] + LIABILITIES [-] + PROFIT/LOSS [+/-] = 0 
 

In the following years: 

                     ASSETS [+]  +    LIABILITIES [-]  +     PROFIT/LOSS +         PROFIT/LOSS        = 0 
                                                                                                                    previous years              end of current year 
 
 

Profits at the end of the year can be withheld by adding them to PROFIT/LOSS from 
previous or distributed years (dividends, taxes, etc.). The important thing is that this 
equation remains valid at the beginning of each year: 

ASSETS [+] + LIABILITIES [-] + PROFIT/LOSS [+/-] =0     
                                                    (carried forward)                                                                                                            

 
At the beginning of the year, the balance of costs and revenues from the previous year 
must be zeroed. 
 
They remain in the Balance Sheet + Income Statement for information purposes but are not 
taken into account for the calculation of the BALANCE Sheet + Income statement. 
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001.How to Load, Analyse and Open the 
SeecompAccounting_demo_100_32/64.xlsm File and Required Commands 

Demo Files Available 

The main demo files available, in addition to other files in diƯerent languages and currencies, 
for download are: 
• SeecompAccounting_demo_100_64.xlsm 
• SeecompAccounting_demo_100_32.xlsm 
• 100 means that the program allows you to work with up to 100 lines of recordings. 
• 64 means that it is for 64-bit devices. 
• 32 means that it is for 32-bit devices. 
 
 We work with an English version of Excel, but you can keep your version in your preferred 
language, keeping in mind that the commands shown will be in the same position, so you 
shouldn't have any diƯiculty following them. Since we have a 64-bit device, we download the 
SeecompAccounting_demo_100_64.xlsm file and save it to a local drive connected to the 
PC, not the cloud. To work properly, the SeecompAccounting_demo_100_64.xlsm file must 
be closely linked to Windows. SeecompAccounting_demo_100_64 or 32.xlsm file is a 
compiled file that contains executable DLL files, which can appear and disappear in 
Explorer—they can be ignored entirely. Compressed (zipped) files may also appear, which you 
can ignore. 

Creating a Copy 

First, make a copy of the file so that if something goes wrong or the file crashes (for the 
beginners at the beginning), you already have a backup without having to redownload it. 

Enabling Macros 

1. Right-click on SeecompAccounting_demo_100_64.xlsm, then select Properties. 
2. At the bottom, you should see the "Enable Macros" option—tick this option. In our case,   
this option is not visible because our settings already enable all macros by default. 

Opening the File 

Now open SeecompAccounting_demo_100_64.xlsm, but don't focus on accounting just yet, 
only Excel commands. If a message appears saying that the file is not optimized, do not 
optimize it, as this may make the accounting data unreadable without blank lines.  Simply 
close the message by clicking on the X in the top right corner without starting the 
optimization process. 

Enabling the Development Tab and VBA Macros 

1. Move the cursor slightly to the right of "File" (in the upper left corner of Excel). 
2. Right-click, then select Customize Ribbon (left-click). 
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3. Enable "Developer" if it's not already selected, then press OK.   You should now see 
"Developer" left of “Help". 
4. Click Developer → Macro Security →Trust Center → Trust Center Setting  
5. Go to Macro Settings → Enable VBA Macros→ OK    We can do this because our macros are 
reliable. 
6. Then Trust Center → Trust Center Setting→ File Block Settings and uncheck all the boxes 
if they are checked. 
7. Click OK and exit. 

Setting the Correct Save Format 

1. Go back near File, right-click and select Customize Ribbon. 
2. Go to Save, then under "Save files in this format," select Excel Macro-Enabled Workbook 
(.xlsm). 
3. Click OK and exit. 

Final Step 

Now your PC is properly configured for VBA calculations with macros. To reinforce these 
steps, let's review the commands just covered so, if something was too fast, you can go over 
them calmly. 
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002. Preliminary Explanations + Excel Commands for Processed Financial 
Statements 

Keep the SeecompAccounting_demo_100_64.xlsm file open and move to sheet 
SIMPLE_BALANCE, located to the left of the BALANCE sheet. This is a minimal BALANCE 
Sheet + Income Statement, useful for explaining that, in order to draw up a Balance sheet 
and an Income Statement, it is necessary to have a Chart of Accounts, that is: an Account 
Number accompanied by a Description. 

Then we will see 3 simple Excel commands that allow you to prepare a detailed Balance 
Sheet + Income Statement in Sheet BALANCE. It is premised that simple commands such 
as filling cells with color must already be known. 

Sheet structure SIMPLE_BALANCE Sheet 
- Column C: Account number 
- Column D: Account description 
- Column E: Account code: 
 
  1 = Assets 
  2 = Liabilities 
 3 = Costs 
 4 = Revenues 
 
For Assets and Liabilities, there is an Opening value, visible in column G, which aƯects the 
calculation of the Balance Sheet. For Costs and Revenues, there is no Opening: the 
amounts are reset to zero every year. However, it is possible to indicate the previous year's 
results for comparison but not aƯects the calculation. 

Main columns 
- G: Opening 
- H: Debits 
- I: Credits 
- J: Balance = G + H – I             Balance = Opening + Debits - Credits 
 
Columns H and I collect the movements from the ACC_JOURNAL sheet. Everything 
highlighted in green is used to calculate the Balance Sheet + Income Statement. 

 Columns C and E should contain only account numbers and codes (1-4). Irrelevant cells 
cause the program to fail. 
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Structure ACC_JOURNAL Sheet 
- A: Date 
- B: Document reference 
- C: Transaction type 
- D: Description 
 
The green columns are those modified by the program: 
- E: Debit 
- F: Credit 
- G: Amount 
- I: % VAT (Value Added Tax) 
 
To change currency: select the columns → right-click → Format cells → Accounting → 
choose Currency → OK 

Structure of the BALANCE sheet 
It is an improved version of SIMPLE_BALANCE Sheet, where: 

- Unused accounts are not deleted. 
- Groups are organized for clarity. 
 
BALANCE SHEET 

Assets: 
- Current Assets  
- Fixed Assets  
 
 AssetsLiabilities: 
- Third Party Capital (Short and Long Term) 
 -Equity  
 
Income Statement: 
- Revenues (before Costs with negative sign (-)) 
- Costs (with positive sign (+) 

 
(-) Negative sign = profit 
(+) Positive sign = loss 
 
Balance sheet verification formula: 
Assets (+) + Liabilities (-) +Costs (+) + Revenues (-) = 0 
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Colors in formulas (column F) 
- Yellow: First Sums 
- Brown: Sum of Yellows 
- Blue: Final Sums 
- Purple: Final Sums 
 
Corrected negative amounts are displayed in red. 
 
To better understand the controls, continue watching the video tutorial. 

Excel commands useful for BALANCE 
1. Auto Summation + Dragging  
- Place the cursor on the cell where you want to indicate the sum 
- Home + Autosum by selecting addends 
- Place the cursor in the bottom right corner of the cell with the Sum’s result until a cross 
appears 
- Hold down the left mouse button and drag to the right  
 
2. Sum of individual cells 
- Type = and manually select the cells to sum (=C4+C7+C10) 
 
3. Freeze Panes- 
 Select the cell below the row you want to freeze 
- Go to View → Freeze Panes→ Freeze Panes 
- The headers will remain visible as you scroll 
- View→ Freeze Panes →Unfreeze Panes for unfreezing 

Final Reminder 
굓굔굕굖 The balance in column J is calculated as:           J = G + H – I        
                                                                                                             SALDO=OPENENIG + DEBITS - CREDITS 
                           
 

藝藜 Now let's slowly repeat all the commands described in the video without comment. 
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003. Backing Up BALANCE Sheet and ACC_JOURNAL Sheet, Renaming 
Sheets, and Using Form Controls 

Problem with blank lines 

Before backing up the ACC_JOURNAL sheet, Excel may sometimes report poor performance 
due to the presence of many blank rows. These lines have been intentionally left to make the 
BALANCE sheet more readable and tidier.  

In these cases: 
• Press Check performance. 
• Do not press Optimize all. 
• Simply close the window by clicking on the X in the top right. 

Backup of ACC_JOURNAL Sheet 

If you select the entire sheet ACC_JOURNAL and copy it to another sheet, Form Controls 
may shift, resize, or appear disorganized. To avoid this, follow these steps: 

1. Delete the first 8 rows of the sheet BACKUP_ACC_JOURNAL. 
2. Cut all Form Controls with select Form Control by mouse, right klick and Cut. 
3. Copy the first 8 lines of Sheet ACC_JOURNAL 
4. Reinsert the first 8 lines in Sheet BACKUP_ACC_JOURNAL. 
4. For subsequent backups, simply copy and paste from line 8 onwards. 

Backup of Sheet BALANCE 

The procedure is like that of the ACC_JOURNAL, but remember: 
• The relevant content of the BALANCE sheet starts from line 9, not line 8. 
 
See also 008. Ctrl+Shift+M (Backup_BALANCE) and Ctrl+Shift+N (BACKUP_ACC_JOURNAL) 

Resetting Form Controls 

Form Controls are used to execute macros. If you accidentally delete one, such as the 
ACC_NUMBER button in the ACC_JOURNAL sheet, you can recreate it as follows: 
1. Go to the UTILITY sheet. 
2. Right-click on the Form Control ACC_NUMBER. 
3. Click Copy, then click on an empty cell and left click to remove the rectangle around the 
Form Control ACC_NUMBER. 
4. Go to the ACC_JOURNAL sheet, left-click the cell where ACC_NUMBER was, then right-
click and choose Paste. 
5. Usually, the Form Control doesn't appear exactly where you pasted it, so you have to 
reposition it:  
o Right-click on the Form Control.  
o Hover the mouse until the move cursor (cross with arrows) appears.    
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o Then left click and drag it to the desired position.    
o Right-click again to display the resize handles (circles), which allow you to resize or 
reposition it by dragging with the left button. You can use this same process for any other 
Form Control. 

Renaming Sheets 

You can manually rename sheets by right-clicking and selecting Rename, but if you do it 
often, it's more convenient to use macros. With a single macro-enabled Excel file, you can 
manage multiple BALANCE Sheets temporarily by renaming sheets as needed. Macros only 
work with the following sheet names: 
 
• ACC_JOURNAL 
• BALANCE 
• ACC_CONTROL 
• ACC_NUMBER 
•UTILITY 
 
To use a specific BALANCE Sheet, temporarily rename your sheets with these names, then 
revert them to their original names when you're done. 

How to quickly rename sheets with a macro 

The program includes the following Form Controls that change the name of the Active sheet. 
Just click on the Form Control and the name will be changed: 
• A_ACC_JOURNAL 
• B_ACC_JOURNAL 
• C_ACC_JOURNAL 
• ACC_JOURNAL (Form Control: ACC_JOURNAL_NAME) 
• A_ACC_BALANCE 
• B_ACC_BALANCE 
• C_ACC_BALANCE 
• BALANCE (Form Control: BALANCE_NAME) 

Alternative method 

• Click on Active_Sheet to see the current sheet number. 
• Go to the UTILITY sheet and, next to CURRENT'S NAME, type the number of the sheet you 
want to rename (you can also write the full current name if you prefer). 
• Next to NEW'S NAME SHEET, type the new name you want to give the sheet — make sure it 
is not already used by another sheet.  
• Then click on the CHANGE Module Control. 
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Form Control Assignment 

It may happen that you press a Form Control, and nothing happens because the assignment 
to the Macro has been lost.  

 

Nothing serious: 

1. Mark Form Control with the Left Mouse Button 
2. Press the right mouse button  
3. Search for Assign Macros and press the left mouse button 
4. All the Macros in use by the program will appear, look for the Macro that has lost its 

assignment and mark it with the left mouse button 

5. Press OK and the Macro will be active again 
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004. Excel Commands for DATA_BASE 

The last Excel commands that we will learn are the ones that are useful for creating a 
DATA_BASE. This will allow you to find accounts quickly while registering in ACC_JOURNAL 
sheet. 

Account structure 

1. Assets 
2. Liabilities 
3. Costs 
4. Revenues 

To improve management: 

1. To frequently used accounts we add the prefix a_, so they appear first. 
2. To the accounts used we rarely add the prefix z_, so they end up at the bottom. 
3. Leaving blank lines in the DATA_BASE Sheet for any new accounts is recommended 

(e.g. zz_ with a provisional number). 
4. No row must be the same as another, otherwise Excel doesn't consider it. 

跚跛跜距 In the cell to the right of the account name, you should always enter the corresponding 
number. 

굓굔굕굖 The DATA_BASE is placed in the ACC_JOURNAL header, but you can also put it elsewhere 
(avoiding cells with green fill or used for calculations). 

Creating the DATA_BASE 

Initial steps 

1. Open the BALANCE sheet for your language. 
2. Copy all the accounts with description and numbers (1, 2, 3, or 4). 
3. Paste into the DATA_BASE sheet with the correct paste values option. 
4. Adjust the formatting of the cells. 

Column arrangement 

1. Insert a new column before the C. 
2. Move the contents of the A to the C. 
3. Delete the old column A. 

Sorting of accounts 

1. Select the entire table. 
2. Go to Data → Sort and sort by column C. 
3. Delete rows that do not contain 1, 2, 3, or 4. 
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4. Check that each account is correctly associated. 
5. Insert 5/6 blank rows between each group (between 1 and 2, between 2 and 3, between 

3 and 4). 

Creating Subgroups 

For example, let's work on group 1 -Assets after the last row with 1, add the reserve accounts: 

1. zz_1, zz_2, zz_3, zz_4, zz_5 
2. Account 10 (provisional) 
3. Preceding frequent accounts with a_, rare ones with z_. 
4. Go to Data → Sort and sort by column A 
5. Sort column A alphabetically (along with B and C associated). 

脥깢깣 Repeat for groups 2 (Liabilities), 3 (Costs), 4 (Revenue). 

Associating with the ACC_JOURNAL sheet 

1. Back to ACC_JOURNAL Sheet. 
2. Select the cell for the account description. 
3. Open Data → Data Validation → Data Validation→Clear all. 
4. Under "Allow" choose List. 
5. Go back to DATA_BASE and select the descriptions of the accounts with 1 (only the 

descriptions)→OK. 
6. Go back to ACC_JOURNAL Sheet and click on the right arrow to see the List. 

Association Description – Account number 

1. In the cell next to the description in ACC_JOURNAL  Sheet, type = and use VLOOKUP  
2. Select the cell with the description (e.g. D2). 
3. Insert the separator (comma or semicolon). 
4. Go back to DATA_BASE Sheet, select columns A and B from Group 1. 
5. Complete the formula: =VLOOK(D2; DATA_BASE! A:B; 2; 0) or 

 =VLOOKUP(D2, DATA_BASE! A:B, 2, 0) 
6. Press ENTER. The account number will appear automatically. 

脥� You can change names and numbers in the DATA_BASE Sheet: if you keep the 
alphabetical order, the associations remain active. 

Repetition for Liabilities, Cost, and Revenue 

Now repeat the same steps for group 2 - Liabilities, without comments, so you can memorize 
them. Then continue with 3 - Costs and 4 - Revenues. 
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Additional Consideration 

Those who work in accounting know the account number by heart in 95% of cases. 
Sometimes the DATA_BASE may not be necessary. It is better than to work directly from the 
Chart of Accounts in the BALANCE sheet. 

 

꺐꺑꺏 To quickly search for an account: 

1.   Press Alt + H, then → Alt + D 
2. Write what you are looking for, place the cursor over an empty cell, and press Find Next 
3. Or: Home → Find & Select→ Find→ Cursor on Empty Cell and→ OK 
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005. FORM CONTROLS BALANCE, ACC_IN and ACC_OUT  

In point 002. we explained how the Balance Sheet and Income Statement derives from the Chart of 
Accounts and how it can be prepared in such a way as to be always updated. 

Obviously, to calculate a Balance Sheet and Income Statement, it is necessary to have Journal 
Entries in ACC_JOURNAL Sheet: otherwise, there is nothing to calculate. 

The postings represent the accounting path of the current year. Amounts paid in the previous year but 
referring to the current year, and amounts paid in the following year but always referring to the 
current year, are also taken into consideration. These are the so-called Accruals and Deferrals, 
Assets or Liabilities. 

To better understand how a Balance Sheet  + Income Statement and a Journal work, let's start with 
the existing Prepared Balance Sheet + Income statement and the existing ACC_JOURNAL Sheet, 
making sure that we have a complete backup of both, as explained in point 003. 

We delete all Openings in BALANCE Sheet with Cancel and all recordings in Sheet ACC_JOURNAL 
with Rows Delete (right click and choose). In your case, you already find the deleted data, but you 
still need to do this by deleting only the Openings data in the green spaces, without touching the 
yellow, brown, or blue filled cells. Otherwise, you'll lose automations that update your Balance + 
Income Statement by simply pressing Form Control ACC_IN. 

Before entering data into ACC_JOURNAL Sheet try to calculate a zeroed Balance Sheet. If each 
account does not correspond to a 1, 2, 3 or 4, Excel itself will report the error with a "debug" 
message. Therefore, check that all the data in the BALANCE Sheet are complete. 

The program cannot understand if you are missing a necessary account in the BALANCE Sheet: it 
can only notify you later if an account in the ACC_JOURNAL Sheet has not been included in the 
Balance Sheet + Income Statement. 

For now, let's leave out VAT (Value Added Tax), which will be covered in the next chapters. 

If you press Form Control BALANCE in ACC_JOURNAL Sheet without having any entries and 
without opening data in BALANCE Sheet, you will get a Balance + Income Statement with all values 
at zero. 

Practical examples: 

 Bank cashout: 

 We receive $100,000 in the Bank (1020) for a Third-party service (3400). 
 Insert: 
  Debit Account: 1020 
 Credit Account: 3400 
 Amount: 100'000 $ 
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 Up to this point, the Balance Sheet + Income statement in BALANCE Sheet is not touched. 
 Place the cursor over the amount, select it and press Form Control ACC_IN. 
 The value is colored pink. In BALANCE Sheet, we see in account 1020 that $100,000 in Debit 

entered in the Bank. 
 The 3400 account shows $100,000 in Credits (negative sign = Gain) 
 At the end of the balance sheet, a profit of $100,000 appears (with a negative sign, which 

represents a gain). The lower controls are still at zero because the Balance Sheet + Income 
statement has not been calculated. 

 Purchase of petrol: 

 We buy $100 worth of Fuel with the Bank card. 
 Insert: 
  Debit account: 6210 (Fuel) 
  Credit account: 1020 (Bank) 
  Amount: $100 
 We select the amount and press Form Control ACC_IN. 
 The value is colored pink. The balance sheet is updated automatically: the profit drops to 

$99,900. 

 Payment of services for third parties: 

 We pay $10,000 for a third-party service. 
 Insert: 
  Debits Account: 5900 
  Credits Account: 1020 
  Amount: $10,000 
 We select the amount and press Form control ACC_IN. 
 The value turns pink and the Balance Sheet + Income statement is updated automatically. 

Lower controls remain at zero. 

5.  Balance Sheet + Income statement calculation: 

 Let's go back to ACC_JOURNAL Sheet and press Form Control BALANCE. 
 Lower controls in the BALANCE Sheet are calculated, and the Balance Sheet + Income 

statement is OK. 
 The amounts in ACC_JOURNAL Sheet are colored yellow, indicating that the Balance Sheet + 

Income Statement has been calculated for those values. 
 If an amount remains pink, it means that the Balance sheet + Income statement has not yet 

been updated for that row. 
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Deleting a recording: 

 We realize that the purchase of Fuel ($100) has been wrongly registered. 
 We select the amount and press Form Control ACC_OUT. 
 The Balance Sheet + Income statement is updated, but the controls no longer coincide. 
 We must therefore recalculate the Balance Sheet + Income statement to realign the Balance 

Sheet Profit with the Control Profit. 
 We press Form Control BALANCE again in ACC_JOURNAL Sheet. 
 Profits are now synchronized: both at $90,000. 

 

These few examples serve to give an idea of how it works. If you work with a SIMPLE_BALANCE 
Sheet , reduced to the essentials, the Profit or Loss will only be visible after pressing Form Control 
BALANCE in ACC_JOURNAL Sheet, since there are no intermediate sums divided into groups. In the 
next chapter we will see how to do the same operations also considering the Value Added Tax 
(VAT). 
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006. Value Added Tax Investment, Value Added Tax Sale, 
           Form Control ACC_NUMBER 

1. Cash out at the bank with 12% VAT 

We receive $100,000 in the Bank for Services provided to third parties. 

 We write: 

• Debits account: 1020 (Bank) 
• Credits account: 3400 (Revenues from Services for third parties) 
• Amount: $100,000  
 
Since this is a sale subject to 12% VAT, we write alongside: 
• S(ale)12 (Sale to 12%) 
• -12 (%) - sign for Sales and + sign for Investment 
We select the amount and press Form Control VAL_ADDED_TAX_SALE . The program 
automatically calculates the breakdown: 
• $89,285.71 as net revenue 
• $10,714.29 as VAT 
 
The total remains $100,000. 
 
As Account for VAT, we use for example 2201 (VAT Statement), but you can have diƯerent 
accounts for percentages or categories. 
 
Let's put both amounts in the Balance Sheet + Income statement with Form Control ACC_IN. 
The data is correct in the BALANCE sheet, while the controls, as in point 005, are still empty 
until we calculate the Balance + Income Statement with Form Control BALANCE in 
ACC_JOURNAL Sheet. 

2. Purchase with 16% VAT 

We buy $100 worth of Fuel (6210) with the Bank card (1020).  

We write: 

• Debit Account: 6210 (Fuel) 
• Credit Account: 1020 (Bank) 
• Amount: $100 
• I16 (16% investment) 
• +16 (% positive (+) because this VAT is an investment) 
 
We see, after pressing Form Control ACC_IN, that the amounts in BALANCE Sheet are 
updated automatically. 
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3.Purchase of services from third parties with 18% VAT 

We pay by Bank (1020) $20,000 for a service received from a Third party (5900). 
 We write: 
• Debit Account: 5900 (Services from third parties) 
• Credit Account; 1020 (Bank) 
• Amount: $20,000 
• I18 (18% investment) 
• +18 (% Investment (+)) 
 
We also use Account 2201 for this VAT entry. We press Form Control 
VAL_ADDED_TAX_INVESTMENT, select the two amounts generated pressing  Form Control 
ACC_IN and see that the Balance Sheet + Income statement is updated again. 

4. Balance Sheet + Income Statement calculation 

We press Form Control BALANCE in ACC_JOURNAL Sheet. 
 
The Balance Sheet + Income Statement is correct: 

• The automatically calculated profit coincides with the one shown 
• The pink values in Sheet ACC_JOURNAL turn yellow, indicating that the balance has been 
updated. 

5. Payment of VAT to the Tax OƯice 

We now have to pay the Tax OƯice the amount of VAT collected from third parties, net of the 
VAT already paid for investments. 
 
To find out how much we have to pay, we place the cursor on the 2201 account both in 
ACC_JOURNAL Sheet and in BALANCE Sheet, and press Form Control ACC_NUMBER_J/B 
depending on the sheet we are on (ACC_JOURNAL Sheet or BALANCE_Sheet). 
 
We immediately see that we have to pay $7'649.65. 
 
Of course, you'll also include the date, document, type, and description in your records for 
clarity. With the Form Control ACC_NUMBER, it is necessary that dates are entered correctly 
in the ACC_JOURNAL sheet. 
 
With the Form Control ACC_NUMBER, we can follow the progress of each Account from the 
moment of opening until up to the BALANCE sheet and income statement of the day.  
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Try, for example, with the 1020 bank account. 

Let's now register the payment at the VAT OƯice: 

• Debit Account: 2201 
• Credit Account: 1020 
• Amount: $7'649.65  
 
We press Form Control ACC_IN. 
The profit does not change, we press Form Control BALANCE in ACC_JORUNAL Sheet : the 
color changes from pink to yellow, a sign that the Balance Sheet and Income Statement  has 
been updated. 
 
Checking 1020 with Form Control ACC_NUMBER in BALANCE Sheet or ACC_JORUNAL 
Sheet, we see the decrease in the Account  and checking Account 2201 we see that we no 
longer have debts with the VAT OƯice as the balance is =0. The payment caused a decrease in 
assets (Bank) and Liabilities (VAT payable). 

6. Restoring the initial state 

Let's now restore ACC_JOURNAL Sheet using the backup made earlier. 
 
In the next chapter we will talk about controls. 
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007. ACC_CONTROL and ERROR WARNINGS and UTILITIES 

The SeecompAccounting_*.xlsm program already includes a good level of automatic checking 
to correct unintentional errors. 

🔹 Move the cursor to the bottom or top of the Balance Sheet and ACC_JOURNAL Sheet 

The Form Controls END_ROW and TOP_ROW allow us to move to the beginning or end of the 
BALANCE Sheet and ACC_JOURNAL Sheet. Form Control SCROLL_ROWS_+20 and      
SCROLL_ROWS_-20 allows to do control and search for errors between the rows.  

Let’s now see some practical examples: 

🔹 Account number error 

Suppose you write Account 6945 instead of Account 6940 in the last line of ACC_JOURNAL 
Sheet. Press Form Control BALANCE in ACC_JOURNAL Sheet and a message appears 
warning that the Balance Sheet and Income Statement are not OK. We activate 
ACC_JOURNAL Sheet and press Form Control ACC_CONTROL: the program warns us that 
the Account 6945 does not exist in the Chart of Accounts. We verify and correct with the 
correct Account, 6940. 

🔹 An account in column E or F is missing 

If an account is missing in column E (debit account) or F (credit account), Form Control 
ACC_CONTROL will notify us. Let’s look for the oƯending line and correct it by entering the 
missing data. 

🔹 Presence of foreign elements 

We accidentally write “qwerty” in column C of BALANCE Sheet. We go back to the 
ACC_JOURNAL Sheet, press Form Control BALANCE and a mismatch warning appears. 
Press OK, then check: 
• That in column C there are only account numbers 
• That in column E there are only values 1, 2, 3 or 4. 
 
 If we can't find the error immediately, we can use the Form Control mismatch from  
ACC_JOURNAL Sheet: it will automatically take us to the row and column with the error, both 
in BALANCE Sheet and in ACC_JOURNAL Sheet. We can also use the classic Excel 
command:  
Home → Find 
Type in the extraneous content (e.g. "qwerty") and fix it manually. 
Or Alt + H and Alt + D and find “qwerty”. 
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🔹 The code 1, 2, 3 or 4 in BALANCE or an Account Number is missing 

In BALANCE Sheet, if one of these codes (column E) is missing from a row, the Form Control 
BALANCE indicates it and indicates the row to be completed. 

🔹 Unidentifiable errors 

If you can't find the error: 
1. Close the file without saving (if AutoSave is not enabled). 
2. Reopen it and redo only the last recordings. 
 
 If AutoSave saved the error: 
1.  Try deleting the rows from the first of the last entries entered up to row 8010 in 
ACC_JOURNAL Sheet. 
2.  If the problem persists, delete all rows from:  
 9 to 8010 in BALANCE Sheet or 8 to 8010 in ACC_JOURNAL Sheet 
3. Finally, restore the data using the previously saved BACKUP_ACC_JOURNAL Sheet. 
 

🔹 Form controls that don’t show up 

It may happen that by pressing ACC_JOURNAL Sheet, you don’t see all the macros in the top 
bar. In this case: 
• Press on another Sheet 
• Then again ACC_JOURNAL Sheet and Form Controls will become visible again. This 
problem is common with underperforming devices or high-resolution screens. 
 

🔹 Macros that pressing them do not work. 

Sometimes macros that you start with Form Controls lose their assignment. Simply place the 
cursor on the 

1. Select Form Control with right click 
2.  Click “assign macro"  
3. Select the desired macro 
4. Press OK 

🔹 Loss of Form Controls 

If you happen to lose the Form Control (Macro) even in the UTILITY Sheet you can take 
another one, change the text by marking the Form Control→right klick →Edit text→ and then 
Assign Macro it to the lost Macro. 
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008. ADDITIONAL UTILITY COMMANDS 

These are commands useful for checking and layout the Journal and the Balance Sheet + 
Income Statement. Several of these commands can be reached very quickly with shortcuts 
that we will indicate. What the user of the program needs to know is the fact that on the same 
device you can use several .xlsm files with diƯerent names when you have to do more 
accounting.  

It may happen that it is necessary to copy the Balance Sheet + Income Statement or a Journal 
from one file to another. In this case the copying can take place but it happens that the Form 
Controls remain assigned to the source file and it happens that, when they are started, they 
open the source file and work on it. To prevent this from happening , we need to assign the 
copied Form Controls to the file to which they were copied. Remember that to access 
Macros you must do Developer → Macros 

We have two possibilities.  

zzd_UpadateMacroAssignement      Ctrl+Shift+U 

Assign the Form Controls of the active sheet to the File with the active sheet open 
 
If the active sheet is a Balance Sheet + Income Statement (BALANCE) we can start  
zza_BalanceAdjust        Ctrl+Shift+B 
 
if the active Sheet is a Journal (ACC_JOURNAL) we can start  
zza_JournalAdjust          Ctrl+Shift+J 
 
With these commands a first correct column width and height are achieved 
of the rows for the Balance Sheet + Income Statement and for the Journal related to the 
default character Aptos 14, then columns B and D are analysed where the cells  
will be modified where necessary to contain wider text to column B or D.  Finally, the Form 
Controls will be assigned to the File with the Active sheet.   
  
To view if the Form Controls have been assigned to the open File we have the following 
macros available:  

zzc_ActiveMacroLocation         Ctrl+Shift+A 

zzc_InactiveMacroLocation     Ctrl+Shift+I 

they indicate which macros and in which cells they are placed: the first command indicates 
which Form Controls are active while the second indicates which Form Controls are inactive.  

Other possibility 
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 zzc_ListFormControls → Run or Ctrl+Shift+L  
returns all the macros on the sheet and their x,y position in pixels which can be useful to 
identify the position of the columns Form Controls necessary for other commands.  

Another command with a shortcut is  

zzd_DeleteFormControls         Ctrl + Shift +D 
it is used to eliminate all the Form Controls present on the Active Sheet.  

zzd  UpadateMacroAssignement      Ctrl+Shift+U  
as already mentioned above, it is used to assign the Forms Controls to the open file in 
execution.  

Other useful commands to quickly BACKUP the BALANCE Sheet  or the ACC_JOURNAL 
Sheet  are the following: 

zzb_ReplaceSheetBALANCE                  Ctlr+Shift+M 

zzb_ReplaceSheetACC_JOURNAL       Ctrl+Shift+N 

Simply activate the Sheet where you want to perform the BACKUP and everything contained 
in this Sheet will be deleted and replaced with the faithful copy of BALANCE or 
ACC_JOURNAL whose name must be present in the Sheets of the open File. Be careful to use 
this command because what is contained in the active sheet will be totally deleted without 
the possibility of recovery and replaced with the contents of BALANCE or ACC_JOURNAL. 

Without shortcuts we find the following commands:  

zza_AdjustRowHeightColB_D  
to be used when the descriptions of BALANCE and ACC_JOURNAL are of such length that 
they cannot be contained with the standard row height in column B or D. 
 
zzz_AlignColumnFixedRightMargin  
this command is useful for those who want to change the distance between the columns of 
the Form Controls: first you have to give the alignment tolerance of the right margin 
(recommended 60) and in pixels the distance between the columns.  
 
zzz_AlignFormControlsColumn 
from an initial alignment and size of several columns which can then be refined with the 
zzz_UniformFormControlDax command . 
 
zzz_ColWidthBalance 
gives the width of the columns in BALANCE which can be changed by the user in succession. 
The width of the columns is the same as the width of zza_BalanceAdjust 
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zzz_ColWidthJournal 
gives the width of the columns ACC_JOURNAL  which sequence can be changed by the user. 
The width of the columns is the same as the width of zza_JournalAdjust 

zzz_DeletePageBreaks 
erases the dotted lines of the sheets where there is a subdivision for printing previously given 
by the user but not useful for printing the BALANCE or ACC_JORUNAL sheets 

zzz_UniformFormControlDax 
it acts on a column and allows you to give a width and height in pixels of the Form Controls: 
the column identifies it with Dax which means the x position in pixels of the left margin that we 
can find with the command zzc_ListFormControls Ctrl + Shift + L. 
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008. PRESENTATION SHEET COMMANDS 

When presenting a Balance Sheet + Income Statement for tax or other purposes, it is not 
necessary to show all the accounts left without use (opening, debit, credit and balance = 0) as 
it is not necessary to show numbers of accounts and how the various items have been added 
together.  As well as it is not always necessary to show the debits and credits steps. The tax 
authorities are primarily interested in the Balance and Income statement of the previous 
year and the closing balance and Income statement of the year in question and, of course , 
in the profit/loss of the year in question.  

To achieve this, start from the BALANCE Sheet  by inserting a Sheet called SUBMISSION to 
the left of it  . 

Let's make a BALANCE Backup on  the SUBMISSION Sheet  by activating it and pressing 
Shift+Ctrl+M or Develop → Macro → zzb_ReplaceSheetBALANCE . 

We can therefore eliminate the Form Controls with Shift+Ctrl+D or Develop or → Macro   →       
zzd_DeleteFormControls, delete the writings in the header and leave room to modify the 
headings and titles necessary for the presentation.      

We must therefore check that the first sums are marked with yellow filling nr 65535 and this 
we can check by marking a cell and starting the appropriate Control Module with Macro 
Development → → SelectedCellColor or Shift + Ctrl + C.   

Then we have to check that the sum of the sums are marked with orange (brown) filling nr 
49407 which we can check as with yellow: without these exact fill colors the program will only 
work by canceling only the accounts with opening, debit, credit and balance = 0.  

The sum of the sums of the sums (we used the blue fill) is generally subjective and must then 
be adjusted by the user but is normally limited to the correction of 2 or 3 sums (see Video 008. 
Submission). 

Once the above is done, simply launch Development → Macro → zzz_Submission 
(presentation) or Shift + Ctrl + S.  

With a few steps you can go to the sums of the sums of the sums (blue fills) by fine-tuning 
what the program has left out and then proceed to hide everything that is not of interest for a 
presentation of the Balance Sheet + Income Statement (see video 008. Submission) 

 

 

 


